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InspectNOW PC User’s Guide  

About this Guide 
The purpose of this User’s Guide is as follows:  

1) Provide step-by-step instructions on the main features of the InspectNOW PC 
inspection and report generation software programs.  

2)  Provide a user-friendly reference tool, should questions arise about the software. 

This User’s Guide has been organized into the following chapters: 

Program Installation: Step by step overview to loading the programs that make up the 
InspectNOW PC for data collection and report writing.  These programs include: 
 InspectNOW for the PC or Tablet 
 Template Maker 
 InspectNOW Office 
 
System Overview: A brief description of various components of the system and how 
they relate to one another. 
 
InspectNOW PC Features:  Step-by-step instructions on how to enter inspection data 
and generate inspection reports as well as a reference for the software features and 
functions. 

Backing Up:  Contains ideas on backing up important data. 

Hints and Suggestions:  Includes hints and suggestions to get the most out of your 
InspectNOW PC software. 

Technical Support:  Places to find technical support for the InspectNOW products. 
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Inspection System Overview 
General Introduction 
The InspectNOW PC software suite is designed to give inspectors the ability to 
rapidly gather home inspection information directly into a hand-held computer such 
as a tablet PC or laptop. 
 
InspectNOW can accelerate the inspection data collection and reporting process. 
With InspectNOW the data is quickly captured electronically from the start and 
throughout the inspection.  This system eliminates the need to re-key information into 
a personal computer back at the office. 
 
One of the most powerful features of InspectNOW is its flexibility.  Users are 
provided two exciting data templates from the start: 
 

1. Matrix Deluxe – the industry standard combination checklist and 
narrative report. 

2.   Property Inspection – a customizable template which gives the  user 
complete control over the information that is being collected and 
reported.   

 
By using Template Maker, a unique application bundled with InspectNOW PC, the 
user can customize categories, steps(components), material checklists, ratings, 
comment libraries, and comment pick lists used in the data collection process.  
 
The system is designed to make on-site electronic data collection and report 
generation fast, feasible and affordable.  You can generate and print the complete 
inspection report on-site, or print a summary and send the full body of the report via 
email or posting to your website.  
 
The narrative report can be printed right from InsepctNOW PC. Open it in the 
respective format of your choice, proof the document and print.  Since the document 
opens in a modified word processor, the user is free to do any enhancements to the 
document that are desired.  Reports are automatically converted to a PDF format 
allowing for easy email or web posting.   
 
If the ITA Matrix Report is desired, all that is needed is to transfer the inspection to 
InspectNOW Office and create a PDF.  (See the InspectNOW Office User’s Guide 
for detailed instructions.) 
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Component Overview  

The InspectNOW Software Suite consists of four main software components:  

1. InspectNOW PC – this application allows for data input via a laptop or tablet PC.  
Once the data is collected a Matrix style report, or a narrative report can be 
produced. 

2. InspectNOW PocketPC – this application allows for data collection on a 
PocketPC.  Summary reports can be printed directly from the handheld device 
with appropriate printing hardware. 

3. Template Maker – this powerful program allows the inspector to modify the 
inspection template, create new templates, modify their comment libraries and 
much more. 

4. InspectNOW Office – this application uses the data collected with InspectNOW 
PC and converts it to the ITA Matrix style report. 

Data Model 

InspectNOW helps the user collect data for many types of inspections.  Shipped with this product 
are two inspection templates, referred to as Document Type within the software: 1.  Matrix 
Deluxe and 2. Property Inspection.  The Matrix Deluxe template is organized like the industry 
standard Matrix Deluxe inspection forms, including the conditions most commonly found during 
a residential inspection.  Both templates also include a robust comment library, the user simply 
clicks on the comment of choice, or enters a customized comment to expand on the conditions 
noted in the report.  Property Inspection template starts out identical to the Matrix Deluxe 
template but allows for unlimited user modification and customization.  This unique two model 
approach accommodates all types of users, from those just entering the profession and looking for 
simplicity and safeguards in their reporting system to the more advanced inspector that wants to 
create their own custom reports. 

Each document has the following hierarchy: 
 
Categories …. major components of a residential property Example: Electrical 
 
  Steps . . . Subcomponents of a Category    Example: Wiring Notes 
      
  Ratings . . . . . Used to identify if further evaluation / repairs are needed 
  Materials . . . Material type, Location and/or Common Conditions 
  Comments . . Additional information or conditions relevant to the step 
  Pictures . . . . Optional items added for further clarification   
  

 
Categories – includes the major components of the typical residential property inspection: 
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General Information Grounds Exterior 
Foundation  Roof  Plumbing 
Heating   Electrical Interior 
Garage   Kitchen  Bathrooms 
Pool / Spa  

Categories can be duplicated within the report.  An example would be Bathrooms.  The inspector 
can create numerous bathroom pages to better identify each bathroom on the property.   

Each Category is made up of a series of Steps (components) specific to that Category.  For 
example, in the Kitchen Category you will see Steps fore Kitchen Sink, Disposal, 
Range/Cooktop, Dishwasher, etc.  

Steps - each step has a Step Detail Window where the following three types of data/comments are 
collected and one additional special feature the CC/Info tab.  These include: 

Rating – the inspector uses a drop down or pick list to pick the rating of choice.  Ratings 
options include: 

Appears Serviceable 
Repairs Recommended 
Safety Hazard 
Not Applicable 

Material – materials appear as a series of check boxes that identify:  
Type of building material such as Stucco 
Location such as Patio 
Common Conditions such as Major Cracks 

 
Comments – used to provide additional comments about the condition of the step.  
Comments can be picked from a categorized comment library or they can be input on at 
the time of inspection.  Comments input at the time of inspection can be added to the 
comment library for future use or used in the one report only.  The section of the report 
expands to accommodate the amount of comments, no space limitations. 
 
Pictures – pictures can be added to the report.  InspectNOW’s unique picture 
management program tags the picture for easy reference. 
 
CC / Info – Code Check 4th edition references are built into InspectNOW.  This makes it 
easy to look up critical references during the inspection.  In addition to the preloaded 
references the inspector can add additional reference materials for easy access.  Now you 
can have a reference library in your hand throughout the inspection. 
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Template Maker 

Most of the elements found in the Property Inspection template can be customized by adding, 
editing, or deleting Categories, Steps, Ratings, and Comments using the Template Maker 
application on your PC.   The comment library and pick lists can also be modified in the Matrix 
Deluxe report.  Modified templates can be transferred to InspectNOW PC or downloaded to the 
handheld device using Microsoft’s ActiveSync application.  (Refer to the documentation that 
came with your handheld on installing, configuring, and running Microsoft ActiveSync.) 
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Section 1 – InspectNOW PC 

Inspection walk-through 

Setting up a new inspection on the PC 

Launch InspectNOW on your PC.  This can be done from the Windows Desktop by clicking the 
“Start” Menu, “Programs”,“InspectNOW”, “InspectNOW PC”.  
 
To create a new inspection document select the "New" menu item from the "File" menu. A blank 
Inspection Setup screen will appear. (See Diagram 1.1)  Use the pen or keyboard to enter general 
information about the inspection such as Dwelling Address, Realtor, Agency, Client Name, etc. 

(Note – to enter data into a specific field, click once on the field to place the cursor in that field, 
then type the information you wish to store in that field.  Use the “Tab” key on your keyboard to 
navigate from field to field or click on the field using the mouse.) 
Diagram 1.1 - Inspection Setup screen 

 

Notice that some fields have a button with a black triangle next to them.  This button indicates a 
popup list associated with the field for quick entry of common data.  You can add your own items 
to these pick lists.  To maintain a pick list, tap the triangle to bring up the list, then tap the “Edit 
List…” item.  A dialog (Diagram 1.2 below) will appear showing you items currently in the list.  
Use the buttons in this dialog to add new items or to delete or edit existing items. 
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Diagram 1.2 - Edit List dialog 

To add an item, simply tap the “Add” button, enter the text for the new item and click OK to see 
the new item in the list. Click OK once more to return to the Inspection Setup screen. 

Now you can tap the triangle to bring up the list with the new item in it.  Tap on the item you 
want and watch as it automatically goes into the field.  (Note – if you bring up a pick list and do 
not want to choose any of the items, simply tap away from the list to make it disappear.) 

One of the most important items to complete on the Inspection Setup Screen is the 
Document Type field.  Other fields may be left blank but you must pick a Document Type from 
the pick list so that Home Inspector will know which category, step, and comment templates will 
be used for this inspection. 

Complete the remaining fields.  Document number can contain both letters and numbers. 

To change the Date and Time, simply tap on the portion of the date or time you wish to change 
and use the up and down arrows at the end of the field to adjust it accordingly. 
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Choosing a category to inspect 

To enter the actual Inspection Data, you first must view a list of categories available for the 
current inspection.  To do this, tap the "View" menu and select “Category List”. 

 

It may take a few seconds to load the list. The Category List window (Diagram 1.3 below) will 
appear. 
 
Diagram 1.3 - Category List window 

 

Notice how the Category List has two columns.  The first column displays the category name.  
The second column shows the status of the category.  By default, all categories in a new 
inspection have a status of  “Incomplete”.  When data has been entered for each step within a 
category, the status field for that category will change to “Complete”.  
 
There are 4 buttons on the bottom of the window.  



 InspectNOW PC User’s Guide Page - 9 

 
Set All Defaults – The "Set All Defaults" button automatically sets the ratings, materials, and 
comments to their default status as defined in TemplateMaker.  
 
Not Present – The "Not Present" button is used when you want to flag a Category as not being 
present on this inspection.  You select the Category by tapping on it’s associated radio button and 
after it is highlighted you tap the "Not Present" button and the status of the Category changes 
from "Incomplete" to "Not Present". 
 
Renaming a category on the fly – The "Rename Category…" button, lets you change the name 
of any selected Category for the current inspection.  This is only for the current inspection and 
does not change the Template data in any way.  All the original Category's Steps, Materials, 
Ratings, and Step Info stay intact.  The only thing different is the actual name of the Category.  A 
good example would be to have a "Bathroom" Category you can rename to "Master Bathroom" or 
"1st Floor Bathroom".  Another example would be a Category called "Other Room" that you 
would rename to a specific interior room like "Den", "Billiard Room", etc.  In the example below 
the “Garage” category is renamed “Carport”. 
 

 
 
Duplicating a category– Borealis has provided a powerful feature that allows you to duplicate a 
Category on the fly.  In other words, if you are inspecting a property that has a second Garage, 
you can use the Garage Category as a template to create a second Garage Category with all of the 
same Steps, and Comments from which to choose.  The Step numbers are the same except a 
number is appended to the end of each Step number.  As an example the Step "57. Floor" in the 
original "Garage" Category would be "57.2. Floor" in the newly duplicated "Garage #2" 
Category. 
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You can also change the number of duplicates you want created by changing incrementing the 
value in the “How Many:” field which defaults to one.  You can also duplicate the data that was 
already filled in from the original Category into the newly duplicated Categories by checking ON 
the “Duplicate with Data” checkbox. 
 
The name of the new Category does not have to stay as the default (like "Bathroom #2") but can 
be changed to anything you feel is appropriate.  You could have a Category called "Other Room" 
and duplicate it numerous times in an inspection to create specific Categories for specific rooms 
that you may run into out in the field.  This feature gives you the maximum flexibility to handle 
any type of homes you might inspect without having to create numerous Room Categories in your 
Template that you only use on rare occasions. It also keeps the main template smaller and easier 
to manage. 
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Step List Window  

Single-click on a category name to view its corresponding step list (Diagram 1.4 below).  
 
Diagram 1.4 - Step List window 

 
 
The Step List window has a list of all the Steps/Components for the Category you clicked.  The 
window consists of 6 columns of data for each Step:  1)Step Title,  2)Rating,  3)Materials,  
4)Comments , 5)Picture and  6)Info. 
 
The Step Title column lists each Step’s number and name.  If the name is too long to fit in the 
column it will have three ellipses (…) at the end. 
 
The Rating column consists of a drop down list of each Step's rating choices.  These drop down 
lists may be different for each Step. Some may have a "Yes, No" choice and others may have the 
normal "Functional, Marginal, Hazardous" Rating.  Some Steps may have no Rating choices at 
all.  These ratings are all user definable in TemplateMaker and will be discussed in more details 
later in the manual. 
 
The Materials column consists of a Material icon that when tapped brings up the Step Detail 
window defaulted into the Materials tab which is discussed further in this manual. 
 
The Comments column consists of a Comment icon that when tapped brings up the Step Detail 
window defaulted into the Comments tab which is discussed further in this manual. 
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The Picture column consists of a Picture icon that when tapped brings up the Step Detail window 
defaulted into the Picture tab which is discussed further in this manual. 
 
The Info column consists of a Step Info icon that when tapped brings up the Step Detail window 
defaulted into the Info tab which is discussed further in this manual. 
 
On the top of the window is the current Category you are in along with the current inspection 
dwelling address.  
 
Double-tapping on the Step title column of a Step also brings up the Step Detail window with it 
defaulting to the Comment tab. 
 
 

Step List Window Buttons 
 

 
 
Back To Categories– Selecting this button will return you to the list of Categories for your 
current inspection.  You can do your inspection in any order you want and jump between 
Categories be returning to the Category List and selecting another Category. 
 
Duplicate Step…– This a very nice feature of being able to duplicate a selected Step for the 
current inspection out in the field.  This new Step is inserted right after the original Step in the 
list.  An example would be a "101. Sink" in a "Bathroom" category. When this Step is duplicated 
the new Step will add a letter to it's Step number so it would become "101a. Sink #2" and it will 
have the same rating choices, materials and comments available to it as the original Step.  You 
can also rename this new Step to whatever you want when duplicating it.  Again, just like 
duplicating a Category this new Step is only for the current inspection and does not change your 
Template Data. 
 
Apply Defaults– In order to make the rating process efficient when few defects are observed for 
a given category, Borealis has provided a feature that allows you to apply rating and material 
defaults.  Just tap the “Apply Defaults” button and all of the unrated steps will receive a default 
rating and any default materials will get checked.  Any Step that has a Rating that has no default 
rating choice will remain blank.  You can determine the default rating and default materials to be 
applied for any given step through Template Maker. (Refer to the Template Maker portion of this 
user’s guide for details.) 
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Entering Inspection Data 
The process of entering inspection data is organized by category.  For every category there are a 
number of steps where the heart of your inspection data is entered. You can have an Inspection 
Step for every item you wish to inspect. (Refer to Template Maker for how to add, change, or 
delete Inspection Steps, Categories, and Inspection Types.)  There is no limit to how many Steps 
you can have in a particular Category.  If there are more Steps then can fit on the screen then the 
scroll bars become active. 

The Home Inspector system gives you four ways to capture information for each inspection 
step: 1) a rating pick list, 2) a checklist of materials, 3) free-form Comments/Boilerplates and      
4) pictures and diagrams. 
 
1) Choosing a Rating – To select a Rating for a Step, simply tap the drop-down Rating List 
and choose the appropriate Rating. (See Diagram 1.5)  These Ratings are customizable in 
TemplateMaker. (Refer to TemplateMaker on how to add, change and delete Ratings) 

Diagram 1.5 - Rating picker item 

 
There are specific Rating choices that have special results when used.  One is the "N/A" rating 
choice.  If a Step is flagged as a rating of "N/A" it will not print on the report BUT will still be 
flagged as completed to have the corresponding Category flagged as "Complete".  This is 
different then just skipping a Step completely which will also cause the Step not to print on the 
report but the corresponding Category will stay flagged as "InComplete". 
 
Two other unique rating choices are "Comments" and "Data".  Any Step that is rated with one of 
these ratings will not print that rating on the report itself.  This means you can rate the Step 
"Comments" in Inspector but when it prints it will only print out the actual comment entered and 
not the Rating name itself.  This resolves the issue of having the rating "Comments" printed 
throughout your report when all you really want to print are the actual comments themselves.  
(The ITA Matrix template does not use this rating choices.) 
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Rating a “Defect” - The system is configured so that if you use the "Repairs Recommended", 
"Safety Hazard", “Defect” or "Comments" rating for a Step, the comment entry screen will 
automatically appear.  According to the ASHI and other Standards of Practice you must enter a 
comment for anything rated as a defect.  Enter your comment and tap “OK” to return to the Step 
List.   

The ability for the Comment entry dialog coming up automatically when a Rating choice is 
selected is controlled by a flag you can set in TemplateMaker for that particular Rating choice.  
See the TemplateMaker section later in the manual for more details. 
 

2) Selecting Materials – To identify Materials for a step, tap the materials icon  

for that step.   The Materials dialog (Diagram 1.6) which consists of a checklist will appear.  
Simply check all the items that apply.  Tap the “OK” button to save the information and return to 
the step list. 
Diagram 1.6 - Materials dialog 

 

(Note – although it may be called the “Materials” checklist, the content of the checklist is not 
limited to materials.  An example of something other than a material type could be a 
manufacturer or different types of weather conditions for a "Current Weather" step) 

Material Comments – InspectNOW PC has a special feature that allows a comment to be linked 
to a particular material choice for a given step.  This is called a material comment. For example, 
whenever you check “asphalt” for a driveway you may want a comment about annual top coating 
to automatically appear for that Step.  Another example may be for a comment warning for 
whenever EIFS type siding is encountered.  A “+” indicates a material has an associated comment 
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attached.  (Refer to the Template Maker User’s Guide for information on how to create “Material 
Comments”.) 
 
Apply Defaults – A feature has been provided that allows you to apply material defaults by just 
tapping the “Apply Defaults” button on the Step Detail dialog.  Any Step with a default material 
will get checked automatically and can help in speeding up the inspection process.  These default 
Materials are set in TemplateMaker. (Refer to the Template Maker User’s Guide for information 
on how to create “Material Defaults”.) 
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3) Entering Comments – To view the comment entry screen (Diagram 1.7) for a 
particular step, simply tap the comment icon 

for that Step.  ITA has provided over a thousand common comments available through the 
comment pick lists.  Tap the pick list drop down box (indicated by a small triangle) to view a list 
of common comments.  Just pick the appropriate comment from the list.  Repeat this procedure to 
enter multiple comments from the list. 

Diagram 1.7 - Comment dialog 
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Fill-in-the-Blank Comments – Some comments may contain an insertion caret ("^").  When a 
comment containing this caret is picked the user will be prompted to supply information to “fill-
in-the-blank” for that comment.  The "Enter Insertion Text" dialog (Diagram 1.8) comes up and 
you enter the appropriate information and tap the “OK” button. The “fill-in-the-blank” 
information will automatically appear at the proper location in the comment. 
 
Diagram 1.8 - Comment "Enter Insertion Text" dialog 
 

 

 

Adding a comment on the fly - If the comment you need is not already in the list, simply write 
or type it into the comment entry area.  To add a comment to the pick list of comments, just tap 
the “Add” comment button.  The comment will now be available in the list for future inspections.  
(Note – To edit or delete comments from the list you must use Template Maker on the PC and 
download the changes to your handheld device.  You cannot edit or delete comments from the 
pick lists in InspectNOW PC itself.  Refer to the Template Maker portion of this user’s guide for 
details.) Tap the “OK” button to save the information and return to the step list. 
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Picker List items - You can also have another picklist inside one of your comments.  An 
example could be "Patio is above ^concrete^ which may cause…” where the "concrete" list item 
has the following list items (“foundation sill plate”, “siding”, “stucco screed”).  This makes it 
possible to pick one of these choices to fill in the blank instead of writing or typing it in. 
 

 
 
(Note- Please see TemplateMaker about creating and editing the List Items) 
 
Comment Labels - You can begin a comment with a label that helps designate the content of the 
comment when it is selected.  This can be important in instances where Comments appear the 
same at the beginning of their text. Labels can also be used if inspectors use certain field-codes in 
the field.  You use labels by enclosing label text in square brackets at the beginning of the 
comment. An example would be "[CCF]Common cracks were found to be present.". This 
comment when selected would automatically strip off the "[CCF]" at the beginning of the 
comment before it was inserted into the comment text area. Labels can also be used to create your 
own sort order or groupings of comments. You might have common comments designated with 
"[+]" at the beginning of them or have all the electrical comments for a water heater all grouped 
together by starting them all with "[electrical]".  
 
Labels can also be used at the beginning of Picker List items. This again helps with sorting the 
List Items with the drop down list so the more common List Items could be flagged to be at the 
top of the list. An example could be a List Item “[1]laundry area” for the previous example that 
would force it to the top of the list.    
 
Comment Auto-Inserts – InspectNOW PC has the ability to have default comments/disclaimers 
that are automatically inserted into the Category comment area as soon as the Category is opened.  
These comments must begin with an asterisk in square brackets. An example would be "[*]Major 
appliances are not tested during the general home inspection process."  This could be a 
comment/disclaimer that you always want present in your report under the KITCHEN category. 
In the report this comment prints right below the Category header and before any Step entries are 
printed. 
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Expanded Text – InspectNOW PC also has the ability to use a type of short-hand called 
Expanded Text.  This feature can be used in any of the Comment text entry areas.  The inspector 
would type in the short-hand code followed by the “@” symbol.  Borealis Inspector then 
automatically expands the short-hand code into its associated text.  An example of this feature 
could be an Expanded Text code of “rr” that could expand to the following text: “Recommend 
evaluation and repairs by a licensed contractor.” The associated text can be of any length from 
one word to an entire paragraph.  There is a “@” button on the Comment text entry area also to 
make it easier to use the Expanded Text feature. 
 
Diagram 1.9 – Expanded Text Example (Before) 

 
 
Diagram 1.10 – Expanded Text Example (After) 
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Using the Comment Multi-Picker - You can also add multiple comments at once by selecting 
the "Multi-Picker…" button. This will bring up the Comment Multi-Picker dialog (Diagram 1.11 
below) that has a selectable scrollable list of all the comments for the current Step. An order 
number will appear before each comment that is selected.  You can change the order by selecting 
an already selected comment and the it will be removed and the order of the remaining comments 
are updated appropriately. Tapping the "OK" button will close the Multi-Picker dialog and insert 
into the corresponding Step's text area the selected comments in the order they were designated.  
Any comments with insertion carets ("^") will bring up the "Enter Insertion Text" dialog for each 
comment. 
 
Diagram 1.11 - Comment Multi-Picker dialog 

 
 
Category Comments  You can also add comments/disclaimers that are particular to a Category 
and not a Step.  These boilerplates are printed right below the Category title but before the Steps. 
You enter these by tapping the Comment Icon button on the taskbar at the top of the screen when 
you are inside the category you want to add the category comment to (See Diagram 1.10 below).  
The same rules as before apply to the comment text area as they did to the Step's comment text 
area.  You can use the comment picker or write or type in your comments and even add new ones 
to your picklist to use in future inspections. 
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General Comment  You can also have comments that are particular to an inspection that you 
want to show at the beginning of your report.  This is a general comment that pertains to the 
entire inspection and is printed at the beginning of the report before any of the categories.  You 
enter this comment viewing the Inspection Setup screen and clicking the “Comment Icon” button 
on the taskbar at the top of the screen.  
 
Diagram 1.10 - Comment Icon on the Taskbar 

 
 
 
Again the some rules apply to this comment text area as to the Step's comment text area.  You can 
use the comment picker or write or type in your comments and even add new ones to your picklist 
to use in future inspections. 
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4) Entering Pictures and Diagrams – One of the time consuming operations for a 
home inspector if they are using pictures in their report is placing their pictures into their report at 
the end of the inspection process.  Having to meticulously place each picture where they want it 
in the body of the report can take up to 15 minutes or more based on the number of pictures the 
inspector took during the inspection.   

To make this task much easier and completely automated InspectNOW PC has a feature that 
embeds picture tags in the report during the course of the actual inspection. All the inspector has 
to do is take a picture and click the “Pict #” button on the Comment screen that will insert a tag 
for that particular picture.  Later at the end of the inspection the media that is in the camera can be 
moved to the PC at the office where the associated pictures will be inserted automatically into the 
report, eliminating having to do it manually.  
 
When the “Pict #” button is clicked in the Comment tab view a Picture Tag Insertion dialog will 
come up and will default to the next picture number. (See Diagram 1.13 below) Each time the 
“Pict #” button is clicked the picture number will be incremented by one.  This number can be 
changed by selecting the “+” or “-“ button.  You can also reset the picture number back to “1” 
by selecting the “Reset Counter” button.  Selecting the “OK” button will then insert into the 
comment area for this Step and Picture Tag. 

 
Diagram 1.13 – Insert Picture Tag dialog  

 
 
The picture tag will consist of a beginning tag “***” and then the actual picture counter 

followed by the scaling factor. An example would be “***Picture-1;Scaling=100***”.  This is a 
picture tag for picture 1 with a scaling of 100%.  You can also change the scaling factor by 
changing the number after the “Scaling=” part of the string.  If you change the scaling value to 
“200” then the picture would print twice the normal size.  If the scaling factor is changed to “50” 
then the picture would print half the normal size. 
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When the picture tag is inserted into the text area for the current Step it will be replaced with the 
corresponding picture when the inspection is printed.  Diagram 1.14 below shows the picture tag 
inserted into the “Sidewalks” Step.  When this inspection is printed the first picture on the camera 
media will be automatically printed in the report in the appropriate Step. 
Diagram 1.14 – Insert Picture Tag example  

 

Diagrams – Diagrams can be automatically included in the printed report also.  By using 
TemplateMaker you can associate any material or comment with a diagram. When this material 
or comment is selected during the inspection process the associated diagram’s pathname is 
inserted into the comment area for that Step.  When the inspection is printed the associated 
material is then printed alongside the material or comment it is associated with. Below is an 
example of a Material “[Knob and Tube]*” associated with a diagram “0049.JPG”. 
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Diagram 1.15 – Material with an associated diagram example 

 

 

In the example above, the diagram tag “***Picture-3;Scaling=100***” contains the pathname to 
the diagram. When the inspection is printed the diagram tag will be used to find the associated 
diagram while printing and will be included during the printing process. If the diagrams are on a 
PC or CD then copy the diagrams needed onto this media.  You will also need to enter the volume 
pathname in the Options field “Default Pict Path”. This field represents the name of the storage 
media that the diagrams are on.  The pathname for the Diagrams uses this field to change the 
pathname to gain access to the diagrams when printing. 
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Inspection Step Detail Screen 

There are 3 ways of getting to the Step Detail screen from the Step List screen.  The most 
common is to select one of the corresponding icons for that Step in the list.  Clicking on the 
Materials icon, the Comments icon, the Picture icon or the Step Info icon brings up the Step 
Detail screen with the corresponding tab defaulted to. In the Diagram 1.11 the user clicked on the 
Material Icon for the “02. Sidewalks” Step and it brought up the Step Detail window with the 
“Materials” tab defaulted to. 
 

 
 
Upon viewing the Step Detail screen it is very easy to switch to the other 3 Step detail screens by 
clicking on the respective tab.  To see the Step Info available for the "Sidewalks" Step, click the 
"Materials" tab.  To see all the Comments for the "Sidewalks" Step, click on the "Comments" tab. 
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Step Navigation 

A very important feature of the InspectNOW PC software is the ability to navigate through each 
step of the inspection process by using the NEXT (">>") arrow buttons on the top left corner of 
the Step detail dialog. 

 

This makes the process of navigating all the steps in a Category faster and using the "Apply 
Defaults" button on the Step List dialog along with it can make the inspection process very 
efficient.  When you are at the last Step for the Category you are in then the NEXT (">>") arrow 
becomes dim and disabled.  Notice the Step Title and Ratings change to correspond with each 
next Step as you navigate. 
 
You can change the current rating for any Step while you are in the Step Detail windows also.  In 
each of the tabs there is a Rating drop down list to switch the Rating without having to return to 
the previous Step List window. 
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Step Info - The "Info" tab in the Step Detail window is reference material that helps the inspector 
know what to look for while performing an inspection.  None of the data that appears in the 
"Info" tab will be part of the report. It is for reference only.  Any Step that has reference material 
like this will have the Step Info icon in its row in the Step List Window.   
 

 
 
Tapping on this icon brings up the Step Detail window with the "Info" tab defaulted to. 
 
Diagram 1.11 Info tab 

 
The Step Info is controlled in TemplateMaker. (Refer to the Template Maker User’s Guide for 
information on how to create “Step Info”.) 
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Viewing Comments Only 
Once you have completed your inspection the Inspection software lets you review your selected 
comments with your client by using the "Review Comments" window.  To view a list of all of the 
comments entered for the current inspection click on "Review Comments" from the "View" 
menu.  A scrollable list of comments will appear. (Diagram 1.12)  To view or edit any comment 
from the list, simply double-click that comment. When you have finished with the comment click 
the “OK” button to return to the comment list. 
 
Diagram 1.12 - Review Comments window 

 
 
The View Rating drop down list will list all of the ratings you are using when you select the down arrow. 
Selecting one of the Ratings will narrow down the Comment list to just the one selected.  Selecting the 
“Summary Comments Only” checkbox will narrow the list of Comments to the ones only rated that would 
appear on the Summary report. 
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Printing a Report Directly from InspectNOW PC 
Go to the “View Menu” and click “Inspection List”.  To print a report take the following steps:  
Select or open the inspection you wish to print.  (Note – single click selects the inspection, a 
double-click opens the inspection.) 

Once you have selected (or opened) the inspection you wish to print, go to the “File” Menu and 
click “Print…” A "Print Properties" dialog will appear (Diagram 1.13) giving you the Print 
Report options.  You can also tap the Printer icon on the main taskbar on the top of the Inspector 
screen. 
 
Diagram 1.13 - Print Properties dialog 

 

Inspection Report -By default, you can print the full narrative inspection report.  Selecting the 
"Print Inspection" radio button will print out the entire inspection with all the data you collected 
for the current inspection.  A page break is inserted after every Category when you print the 
report.  This makes it much easier to reprint a single Category when changes are made without 
having to reprint the entire report.  

Continuous option - If the "Continuous" check box is checked this suppresses the page break 
after every Category in the inspection report.  Each new Category and its associated Steps are 
printed after the previous Category in a continuous report that makes the report shorter and a little 
quicker to print.  The disadvantage of printing the continuous report is when you need to reprint a 
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specific Category you will need to reprint all the Categories after the correction in the report.  If 
each Category has a page break you only need to reprint that one Category again. 

Print Summary – Select the “Print Summary” radio button to print just the Inspection Summary 
Report.  This is a condensed report that only prints out the Steps and Comments that were flagged 
as significant and should appear on the Summary.  This is controlled by the rating choice that is 
selected for each Step.  An example could be a rating choice called "Defects" that would force the 
Step and any Comments for that Step to print on the Summary report.   
Controlling which rating choice has the Summary flag set is set in TemplateMaker. (Refer to the 
Template Maker User’s Guide for information on how to associate a rating choice to the 
Summary report. 
 
Rating Summary Report – To print a Summary report for a specific Rating you select the 
appropriate Rating from the Rating choice drop down list that is just to the right of the “Print 
Summary” radio button.  To print a Summary Report for just Steps rated as “Defective” you 
would select the “Defective”Rating along with the “Summary Report” radio button. 
 
Print Major Systems - A new report that is unique to the Borealis Inspector software is the 
ability to do the actual inspection room by room and then print the summary inspection report in a 
different order or arrangement.  One of the more common ways would be to print the report by 
Major Systems like Plumbing, Electrical, Structural, etc.   This means that you can do your 
inspection in the order you want but have the ability to sort the results in a different order for the 
Summary report for the Real Estate agent.  Each Step in the inspection process has a field called 
"Keyword" that is used to categorize that Step.  An example could be the "79.Sump Pump" in the 
"Basement" category that would have a Keyword of "plumbing".  When the "Major Systems" 
report is printed the "79. Sump Pump" Step will be categorized together with all the other 
"plumbing" steps no matter what Category it is in. 
 
Setting the "Keyword" field for a Step is done in TemplateMaker. (Refer to the Template Maker 
User’s Guide for information on how to do this.) 
 
Page Selection – To print specific pages select the “Pages” instead of “All” and then fill in the 
“From” field and then the “To” field.  If you needed to print page 9 over again you would select 
the “Pages From” radio button and then put the number “9” into the “From” and “To” fields.  
(Note: If you change the “Starting Page #” field then make sure to change the “From” and “To” fields 
appropriately.) 
 
Starting Page # - If there are other preprinted pages you need to include in your report before the 
inspection report you can change the beginning starting page number that is printed from the 
Borealis Home Inspector software.  If you have a 2 page legal page you want to include at the 
beginning then the Starting Page # would be changed to 3. 
 
Number of Copies – Use this field to print multiple copies of the report you are printing.  You 
can use it for the full inspection report or the Summary report.
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Print Dialog 

Once you have selected the type of report you want to print and the print options in the Print 
Report dialog and have clicked the OK button the standard Windows print dialog (Diagram 1.14) 
will appear as shown below. 
Diagram 1.14 - Print Dialog 

 
 
The default Windows printer will be selected.  Click “OK” to print the report to the default 
printer.  Refer to the documentation that came with the printer for details. 
 

Printing the ITA Matrix Report Form 
 
In order to generate the ITA Matrix Report output you must export the inspection from 
InsepctNOW PC and import it into InspectNOW Office.  See the instructions that follow. 

Select the inspection in the Inspection List window or open the inspection you wish to export and 
go to the “File” Menu and tap “Export RTF”.  

 

The "Export RTF" dialog will appear (Diagram 1-16).  There are the options of exporting a full 
Inspection Report, a Summary Report or a Major Systems report.  Select the appropriate option 
and click the "OK" button.  Click on the “Include Pictures” checkbox if you want to include the 
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pictures in the RTF file also.  Use the Ratings drop down list for exporting specific rating type 
Summary reports. 
Diagram 1.16 - Export RTF dialog 

 
 
You also have the ability to change the name of the report for this inspection. Change the name 
that appears at the top of each page of the report by changing the “Report Name:” field. This field 
will default to the name of the Doctype of the current inspection. 
 
The “Export All” checkbox will cause all the inspections in the Inspection List will be exported at 
the same time. After all the inspections are exported a confirmation dialog will come up and ask 
if all the inspections should be deleted from Inspector once they are all exported. 
 
A standard “Save As” dialog (Diagram 1-17) will appear giving you the opportunity to name the 
file and to identify the directory the file is to be saved into. The exported document will default to 
a name with the Document# in it. Most inspectors name the RTF inspection document by the 
document/inspection number or by the dwelling address of where the inspection was done. 
 
Diagram 1.17 - Save As dialog 
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Save the RTF file to the C:\Program Files\InspectNOW\Import-Export\ directory.  This 
should be done before going to the next inspection.  This would create a backup of the 
inspection just completed. 

Click the “OK” button to complete the export. (Note –To view the properly formatted document 
you must use Microsoft Word or a compatible word processor on your PC.)  
Once the export has completed, double-click the document on your PC to open it with the default 
word processor.  The exported document will contain all of the inspection data in a narrative 
report format. Once it is in your word processor you can include your digital photos or Carson 
Dunlop images easily and have a very professional report in minutes. 
 
You have many options as to how the format of the inspection report is defaulted.  The report can 
have as many as four columns or just one column as a fully narrative report.  Each column can 
also be resized as to its width.  (Refer to the Template Maker User’s Guide for information on 
how to do this.) 
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Deleting an Inspection 
 
To delete an inspection go to the Inspection List view and select the inspection that you want to 
delete.  Either select "Delete Inspection" from within the "File" menu or click the Delete Icon (red 
X on the icon bar). A Confirm dialog will display the properties of the inspection about to be 
deleted. (Diagram 1-18) Click the "Yes" button to delete the inspection. A progress bar will 
appear as the inspection is being deleted. This can take a few moments to execute.  Please wait 
until the process has completed.  Do NOT shut down your PC during this process. 
 
Diagram 1.18 - Delete Warning dialog 

 
 

Duplicate an Inspection 
 
To duplicate an inspection from the InspectNOW PC, view the Inspection list and select the 
inspection to be duplicated by single-clicking it.  Click the "Duplicate Inspection…" button. 
When the Duplicate Inspection dialog comes up (Diagram 1-19) then enter a new document 
number for the newly duplicated inspection.  This way you will be able to distinguish it from the 
original.  Click on the “OK” button and the currently selected inspection will be duplicated along 
with all of its Categories, Steps, Ratings, Materials and Comments.  This is a good way of 
creating a generic inspection template and then using it as a base inspection to start from.  This 
can help shorten the inspection process on site.   
 
WARNING: Using the Duplicate Inspection feature can also make it easier to make 
mistakes and forget to change previous set defaults.  Use this feature very cautiously. 
 
Diagram 1.19 - Duplicate Inspection Dialog 
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Merging partial inspections 
 
Sometimes during big inspections it is beneficial to have more than one inspector at the 
inspection site. InspectNOW PC can merge partial inspections together from multiple inspectors 
to create a final inspection.  There is no limit to the number of partial inspections that can be 
merged.  The inspection job can even be broken up within a single category.  This means that one 
inspector could be inspecting the appliances in the Kitchen category while another inspector is 
inspecting the electrical outlets.  When the merge process occurs the software will successfully 
merge the separate steps within the Kitchen category appropriately.   
 
To start the merge process you must decide who will have the final completed inspection. The 
other inspectors will then need to select the partial inspection they have completed and then select 
the “Export Inspection” menu item from the “Merge” menu.   
 

 
 
The “Save As” dialog (Diagram 1-20) will come up where you will browse to where you want to 
save the partial inspection file.  Name the partial inspection what you want in the “File name:” 
field and select the “Save” button.   
 
Diagram 1.20 – Save As dialog 

 
 
Once you have exported the partial inspections from the other inspectors you will need to get 
these exported files to the master device where the final inspection will be completed from.  This 
can be accomplished by either copying the file to an external media device like a USB Drive, or  
CF card, SD card or other comparable medias.  You can also send the file from one device to 
another using Irda or other wireless communications. 
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Once the partial file(s) are transferred to the computer or device that the final inspection will be 
created on you will then launch the inspector app that contains the final inspection and select the 
“Import Inspection” from the “Merge” menu. 
 

 
 
From the “Open” dialog (Diagram 1-21) select the partial inspections you have exported from the 
list and select the “Open” button. This will add this inspection to the list of imported inspections 
in the inspection database. Select the inspections to be merged.  You can import these partial 
inspections at any time.  The inspector in charge of the final inspection could be half way through 
his portion of the inspection and import the partial inspections of the other files and then complete 
his portion and merge all of the data together at a later time. 
 
Diagram 1.21 – “Open” dialog 

 
 
Once the partial inspection files are imported and you are ready to merge all the data together you 
select the master inspection you want to merge into from the Inspection List view in Inspector.  
Once the inspection is highlighted, select the “Merge Inspection…” button.  In the example below 
(Diagram 1-23 & 1-24) we are selecting the inspection for Joe Smith and merging in the partial 
inspections with the inspection numbers of 1316 and 1317. Once the partial inspection documents 
are merged in you will be able to see all the inspection data in the original inspection plus all the 
partial inspection data merged into it also. 
 
Remember inspections can be merged across handhelds of the same type or even across a CE 
tablet and a PocketPC.  Some inspectors will also use the merge feature to do a partial inspection 
on a handheld and then export it and merge it into the original inspection on the PC version of 
inspector.   
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Diagram 1.22 - Sample of merging inspections 

 
 
Diagram 1.23 – Merge Inspection List dialog 
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InspectNOW PC Options 
InspectNOW PC has specific options that can be used to customize the inspection and reporting 
process.  Some options for report output include font size, legal text and many others.  To view 
InspectNOW PC options, go to the “File” Menu and click the “Options” item.  The "Options" 
dialog will appear with 6 tabs: (General, Owner, Header/Footer, Legal Text, Def of Terms, 
Summary Disclaimer.) 
 
InspectNOW PC General Options 

General Tab  

 

Report Step Spacing – This is the option of having a single or double spacing between each Step 
line in the report.  
 
Materials Delimiter – This designates what character is used to separate multiple materials in 
your inspection report.  You can also leave this blank if you do not want any materials delimiter. 
 
Report Font Size – This sets the default font size for the main body of the inspection report.  
Currently it can either be a 10 or a 12 pt. font.  This is reflected in the printed reports and any 
exported RTF reports sent over to the PC also. 
 
Report Font Name – This sets the default font for the main body of the inspection report.  It 
must be a valid font on the computer you are running the inspection software on. 
Column Widths – Each Column in the inspection report can be controlled. Currently there are 4 
types of report formats supported.  There is a 4-column, 3-column, 2-column report and a single 
column narrative report.  The 4-column report actually contains 5 columns: (1-Step number, 2-
Step Title, 3-Materials, 4-Rating, 5-Comments).  The 3-column report combines the Materials 
and Comments into the last column. The 2-column report combines the last 3 columns into 1 
column which means the materials, ratings and comments are combined in the last column.  
There is also a completely narrative report. 
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Whenever you change one column make sure to compensate another column so that the total of 
the 5 columns combined stay the same. 
 
Show Step numbers – This flag turns on or off showing the Step Numbers in the inspection 
software in the Step List view.  This gives the ability to show more of the Step Name.  This is 
most important when the inspection software is running on a PocketPC which has a limited sized 
screen to show the Step Names on. 
 
Default Step Page – This option setting lets the user set which tab of the detailed step once you 
double-click a Step it will default to. There are four tabs in the detailed Step dialog which 
includes Materials, Comments, Picture and Info. An example would be if the Materials item is 
selected then each time I double-tap on a Step the Step Item would default to the Material tab 
every time. 
 
Data Paths – There are 2 datafiles associated with the Borealis Inspector application.  Whenever 
a new inspection is created it is saved in the data file pointed to by the "Inspection_Data" field.  
Use the Browse button next to that field to change the link.  The default link is 
"MyDocuments\Inspection_Data.cdb" datafile for the CE and PocketPC versions and “C:Program 
Files\Borealis Inspector\Inspection_Data.mdb” for the PC version. 
 
The template data that is used when creating a new inspection is the datafile pointed to in the 
"Template_Data" field.  Use the Browse button next to that field to change the link.  The default 
link is "MyDocuments\Template_Data.cdb" datafile for the CE and PocketPC versions and 
“C:Program Files\Borealis Inspector\Template_Data.mdb” for the PC version.  This should be the 
datafile that is shared between the handheld and the PC, and is the template datafile linked to 
TemplateMaker on the PC. 
 
Activation Code button – This button is used to bring up the Activation Code dialog to change 
the number of new inspections the inspector application can create for the limited version. 
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InspectNOW PC Owner Options 
 
Owner Tab 

 
 

Name, Company, Address, Phone – Enter the inspector name, the inspection company name 
and address, and inspection phone and fax numbers.  
 
InspectNOW PC Definition of Terms Options 

Definition of Terms Tab 

 
 
Def of Terms - The text you place here is used to define the Ratings used on the cover page of 
the inspection report.  Don’t forget to add the corresponding definitions for any new Rating 
Choices you may have created with Template Maker. 
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InspectNOW PC Header/Footer Options 
 
Header/Footer Tab 

 

Print company info – Check the “Print company info on reports” checkbox to have the Borealis 
Inspector application pull the company information from the Windows CE Owner information 
located in the Windows CE control panel onto the inspection report.  It is also pulled from the 
Owner Info on the PocketPC.  This information prints on the header of the report.  You may want 
this checkbox off when you are using company letterhead on the pages of your report to suppress 
the printing of the company info.  

Hide ratings on report – This option lets the user suppress the ratings being printed on the 
report. Some inspectors may want to use a rating system to help decide what items get put on the 
Summary report but do not want the rating to show on the inspection report itself. 

Blank line between comments – This option lets the user turn on the feature of having a blank 
line inserted between each comment when there are multiple comments selected for a single Step.  
This also works when the MulitPicker is used for picking multiple comments at once for a single 
comment.  

Section break between Categories – This option lets the user turn on or off the feature of a page 
break being automatically inserted between each Category when an inspection is exported as an 
RTF file. 
 
Footer Text - The text entered in this text field appears as the footer for each page in the report 
and in the exported RTF file transferred to the PC. 
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InspectNOW PC Legal Text Options 
 
Legal Text Tab 

 

Legal Text - Text entered into this text field prints on the first page of the report in the Legal 
section. 
 
InspectNOW PC Summary Disclaimer Options  
 
Summary Disclaimer Tab  

 
 
Summary Disclaimer Text - The text you place here is printed on the header section of the 
Summary Report.  Many times you want a different disclaimer printing on the Summary Report 
then on the normal inspection report. 
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Menu Reference 

File Menu  

 

The following features are accessible through the File menu: 

New  

Click “New” to create a new Inspection record. 

Delete Inspection 
Once and inspection has been selected in the Inspection List view, use the “Delete Inspection” 
item from the “File” menu to remove it from the system.  A Confirm dialog will display the 
properties of the inspection about to be deleted (Diagram 1-18) Click the "Yes" button to delete 
the inspection. A progress bar will appear as the inspection is being deleted. This can take a few 
moments to execute.  Please wait until the process has completed.  Do NOT shut down your PC 
during this process. 

Print… 

Click “Print…” to print the current inspection using the narrative report format.  This can only be 
done from the Inspection List view. (See “Printing a Report” for details on printing an 
inspection.) 

Export RTF… 

Click “Export RTF…” to generate a Rich Text formatted word processing document from the 
current inspection. This is the menu item you use to create a document of your inspection which 
you transfer from the handheld to your PC.  

Options 

Click “Options” to set General, Header/Footer, Legal Text, Definition of Terms and Summary 
Disclaimer options for the system. 
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View Menu 

 
The following features are accessible through the View menu:  

Inspection List 

The Inspection List view displays all the Inspections that are currently stored in the system.  You 
should be in this view when deleting an inspection. 

Inspection Setup 

The Inspection Setup item displays the Inspection Setup entry screen for the selected inspection.  
General information about the inspection, such as client name and address, inspection number, 
and inspection date are entered here. 

It is on this screen that the Document Type is selected.  The Categories and Steps that become 
available for this inspection are established when the Document Type is selected. 

Category List 

The Category List item displays a list of Categories associated with the current inspection.  From 
this list you can view the Category names and their status.  
Note: If this list appears blank you may have forgotten to select a Document Type from the Inspection 
Setup view.  Go back to this view and select a Document Type first and try again. 

Review Comments 

The Review Comments item allows the user to view a list of all of the comments that have been 
entered for the current inspection. 

To easily edit a comment when using this view to review with a client simple double-tap a 
comment to view or edit it using the comment entry screen. 

HTML View (Not applicable in the PocketInspector version) 

When you select the HTML view it shows the entire inspection report as it will print out or 
appear as a web page.  There also are index items to the left that when selected will jump you to 
that section of the inspection to review.  This also previews the exact interface that anyone 
viewing the inspection on a web page would see.
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Help Menu 
About Inspector… 
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Tips and Helpful Hints 
- Use Step numbers that are at least 4 digits long to have the sorting work correctly 

across Categories. Use "0010" instead of just "10".  
 
- You can use letters in your Step numbers to insert Steps between existing Steps like 

"1211b" would be between Steps "1211" and "1212".  
 
- The information printed on the top heading section of the inspection report that 

contains the company information and telephone number is pulled from the "Owner 
Info" application in the "Control Panel" on the handheld. You must go there to 
change this information. NOTE: CHANGING THE USER NAME ON THE 
HANDHELD WILL CAUSE THE INSPECTOR APPLICATION TO BE 
REREGISTERED.  PLEASE MAKE SURE YOU CAN GET A HOLD  OF 
BOREALIS FOR A NEW REGISTRATION CODE BEFORE DOING THIS. 

 
- To change the column widths in the inspection report you need to go into the 

"Options" menu and you will see 5 fields that contain the width used for each column. 
You must change these values on the handheld to make specific columns wider or 
narrower in the report. The column values are in inches.  

 
- Use the Step Navigator button and the "Apply Defaults" button in Inspector to more 

quickly navigate through a Category's Steps and remember you can change the rating 
directly in the Step detail dialog on the bottom popup list. 

- In Template Maker you must save a newly created Material Item first by closing the 
material dialog and coming back in before adding an associated comment to it. 

 
- In Template Maker you must save a newly created Step Comment first by closing the 

Comment dialog before you adding a Step Link to it for another associated Step. 
 
- When you have multiple handheld devices and need to update the Template_Data 

files, instead of connecting each handheld to the PC where TemplateMaker is you can 
update one of the handhelds and then beam the "Template_Data" files between the 
rest of the handhelds. Reference the "Help icon" on the handheld for information on 
beaming. 

Technical Support 

support@borealisweb.com 

www.borealisweb.com 


